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WARNING
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Getting  Started
The EPSON® ActionLaserTM 1100 printer combines high
performance and reliability with a wide range of features.

To get started with your ActionLaser printer, please:

Read the safety information, laser printer precautions, and
important safety instructions in this introduction.

Use your Read This First guide to set up and test your new
printer.

Refer to this Reference Guide for detailed information about
your printer.

Where to Get Help for U.S. and Canadian Users

Epson America provides local customer support and service
through a nationwide network of authorized EPSON dealers
and Service Centers.

If you need to call for technical assistance, please print a test
sheet and have it handy. To print a test sheet, turn the printer
on and then briefly press the reset button on the back of the
printer. (Make sure the Error light is not on.)

EPSON also provides the support services listed below
through EPSON Connections.SM U.S. users can call (800) 922-8911;
Canadian users can call (800) GO-EPSON.

Assistance in locating your nearest Authorized EPSON
Reseller or Service Center

Technical assistance with the installation, configuration,
and operation of EPSON products
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EPSON technical information library fax service

Product literature with technical specifications on EPSON’s
current and new products

Customer Relations

You can purchase supplies, parts, documentation, and
accessories by calling EPSON Accessories at (800) 873-7766
(U.S. only).

CompuServe@ On-line Support

The fastest way to access helpful tips, specifications, drivers,
application notes, and bulletins is through the Epson America
Forum on CompuServe.

If you are not currently a member of CompuServe, you are
eligible for a free introductory membership as an owner of an
EPSON product. This membership entitles you to:

An introductory $15 credit on CompuServe

Your own user ID and password

A complimentary subscription to CompuServe Magazine,
CompuServe’s monthly publication

To take advantage of this offer, call (800) 848-8199 in the United
States and Canada and ask for representative #529. In other
countries, call (614) 529-1611 or your local CompuServe access
number.

If you are already a CompuServe member, simply type
GO EPSON at the menu prompt to reach the Epson America
Forum.
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Safety Information

Laser safety

This printer is certified as a Class 1 laser product under the U.S.
Department of Health and Human Services (DHHS) Radiation
Performance Standard according to the Radiation Control for
Health and Safety Act of 1968. This means that the printer does
not produce hazardous laser radiation.

Since radiation emitted by the laser is completely confined
within protective housings and external covers, the laser beam
cannot escape from the machine during any phase of user
operation.

CDRH regulations

The Center for Devices and Radiological Health (CDRH) of the
U.S. Food and Drug Administration implemented regulations
for laser products on August 2, 1976. Compliance is mandatory
for products marketed in the United States. The label shown
below indicates compliance with the CDRH regulations and
must be attached to laser products marketed in the United
States.

This Product complies with
regulations 21 CFR Chapter 1,
Subchapter J, section 1010, 1040.

Epson America, Inc.
20770 Madrona Ave.
Tonance, CA 90503 USA
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Warning:
Use of controls, adjustments, or performance of procedures
other than those specified in this guide may result in
hazardous radiation exposure.

Your printer is a Class 1 laser product as defined in IEC 825
specifications. The label shown below is attached in countries
where required.

Internal laser radiation

Max. Radiation Power

Wavelength

5mW

780 nm

This is a Class IIIb Laser Diode Assembly that has an invisible
laser beam. The printer optical unit is NOT A FIELD SERVICE
ITEM. Therefore, the optical unit should not be opened under
any circumstance.

Ozone emission

During printer operation, a small amount of ozone is released.
This amount is not large enough to affect human beings
adversely.

However, it is best to make sure the room where you are using
the printer has adequate circulation, especially when you are
printing a high volume of materials or using the printer
continuously over a long period of time.
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Laser Printer Precautions

This printer uses laser technology. The following list of
precautions applies whenever you open the cover. Even if you
are familiar with other types of printers, be sure to follow these
precautions carefully to ensure safe, efficient operation.

Avoid touching the components inside the printer unless
instructed to do so in this guide.

When you open the printer or remove the toner cartridge,
you expose components inside the printer that can be
very hot. Avoid touching the fuser area, which is located
immediately above the toner cartridge when you open the
front cover, and the motor, which is further inside the
printer.

Do not scratch the surface of the drum, which is the green
cylinder that can be seen through an opening of the toner
cartridge. Avoid touching the drum, since oils from your
skin can permanently damage its surface and may affect
print quality.

Avoid pressing on the top of the toner cartridge. Pressing
directly on the cartridge may cause toner to spill into the
printer. If there is a spill, see Chapter 3 for cleaning
instructions.

Never force the printer’s components into place. Although
the printer is designed to be sturdy, rough handling can
damage it.
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The toner cartridge is the part of the printer mechanism that
forms the image and transfers it onto the paper. Keep the
following guidelines in mind whenever you handle the toner
cartridge:

When removing the toner cartridge, avoid exposing it to
room light any longer than necessary. Exposure to light can
damage the drum, causing dark or light areas to appear on
the printed page and reducing the service life of the drum.
If you need to keep the cartridge out of the printer for long
periods, cover it with a cloth.

Do not turn the cartridge upside down or stand it on its
sides.

Do not attempt to modify or take apart the cartridge. It
cannot be refilled.

Try not to touch the toner and avoid all contact with your
eyes.

Do not use a cartridge for at least one hour after moving it
from a cool to a warm environment.

To get the best print quality from your toner cartridge, do not
store the cartridge in locations that are subject to direct
sunlight, dust, salty air, or corrosive gasses (such as ammonia).
Also avoid locations subject to high temperatures or humidity
or abrupt changes in temperature or humidity.
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Important Safety Instructions

Read all of these instructions and save them for later reference.
Follow all warnings and instructions marked on the printer.

Unplug the printer before cleaning. Clean with a damp
cloth only. Do not spill liquid on the printer.

Do not place the printer on an unstable surface or near a
radiator or heat register.

Do not block or cover the openings in the printer’s cabinet.
Do not insert objects through the slots.

Use only the type of power source indicated on the
printer’s label.

Connect all equipment to properly grounded power
outlets. Avoid using outlets on the same circuit as
photocopiers or air control systems that regularly switch on
and off.

Do not let the power cord become damaged or frayed.

If you use an extension cord with the printer, make sure the
total ampere rating of the devices plugged into the
extension cord does not exceed the cord’s ampere rating.
Also, make sure the total of all devices plugged into the
wall outlet does not exceed 15 amperes.

Except as specifically explained in this Reference Guide, do
not attempt to service the printer yourself.

Unplug the printer and refer servicing to qualified service
personnel under the following conditions:

If the power cord or plug is damaged; if liquid has entered
the printer, if the printer has been dropped or the cabinet
damaged; if the printer does not operate normally or
exhibits a distinct change in performance. Adjust only
those controls that are covered by the operating
instructions.
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About this Guide

This guide contains information for operating and maintaining
the printer once you have installed it. For information about
installing and setting up the printer, see Read This First.

Chapter 1, “Using Your Printer,” lists the printer’s features and
describes how to control the printer and load paper.

Chapter 2, “Changing the Printer Settings,” describes how to
change printer settings using the Windows” printer driver.
Printer driver settings allow you to do such things as change
the toner density, turn on toner saving mode, and specify how
long the printer is idle before it enters power save mode.

Chapter 3, “Troubleshooting,” gives helpful information for
avoiding printer errors, optimizing print quality, and solving
any problems you may encounter.

Appendix A contains the technical specifications about the
printer.

Appendix B describes how to use the EPSON Control Panel for
DOS to control the printer. This appendix is intended for users
who do not have Microsoft’ Windows.

Appendix C lists the commands that can be used to control the
printer. This appendix is intended for advanced users only.

Appendix D gives step-by-step instructions for installing a
Single In-Line Memory Module (SIMM) so you can increase
printer memory up to 5MB.
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About Your Printer

The ActionLaser 1100 is the latest in EPSON’s advanced line of
laser printers. It emulates the Hewlett-Packard® LaserJet® III
(LJ3) printer, allowing you to print using the wide variety of
software programs that support HP® printers. You can control
the printer from either the Windows or the MS-DOS®

environment.

The printer gives you the ability to produce good-looking,
professional documents and publications. Its 300-dpi resolution
is enhanced by the edge smoothing feature, which smoothes
jagged edges of diagonal lines in text and graphics and gives
your document a clean crisp appearance.

The ActionLaser 1100 is quiet and is easy to install and use.
You simply set it up and connect it to your computer as
described in Read This First. To use the printer, just bring up
your software program and use the Print menu option under
your File menu. From the Print menu, you can access the
settings that allow you to control the print job and the printer
itself.

Features

The ActionLaser 1100 comes equipped with a built-in
bidirectional parallel interface and with 1MB of memory, which
can be expanded up to 5MB. See Appendix D for more
information about installing additional memory.

The other main features are described below.
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Toner saving mode

The toner saving mode allows you to reduce the amount of
toner used in printing draft documents. When you turn on
toner saving mode, the printer applies less toner to each page,
causing text and graphics to appear gray rather than black. The
toner saving mode settings allow you to control how light or
dark you want the toner to be applied.

EPSON Control Panel utility

The EPSON Control Panel for Windows keeps you informed
of the printer’s status and notifies you of printing errors. Each
time the printer status changes, such as when the paper tray is
empty or an error occurs, a message automatically appears on
screen. In case of an error, the message informs you of what
steps to take to clear the error.

Note:
If you are not using the printer in a Windows environment, the
Reporter, which is included with the EPSON Control Panel for DOS,
keeps you informed of the printer status.

Energy Star compliant

Your EPSON printer complies with the U.S. Environmental
Protection Agency’s Energy Star program, which promotes the
manufacture of energy-efficient printers, computers, and
monitors. The printer conserves electricity by automatically
entering a low-power, standby mode when not in use for a
specified period of time (default is 15 minutes).

The EPA estimates that if all desktop computers, printers, and
other peripheral devices met Energy Star standards, energy
cost savings would exceed $1 billion annually and carbon
dioxide emissions would be reduced by 20 million tons.
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All of EPSON’s dot matrix and ink jet printers conform to
Energy Star standards, as do all ActionLaser printers produced
after June, 1993.

The Energy Star emblem dues not represent EPA endorsement of any
product or service.

Optional PostScript® emulation

Optional software is available that allows you to print
documents formatted for PostScript Level 2. Call your dealer
or EPSON Accessories for more information.

Adjusting the Power Save Mode

In compliance with the Energy Star program, the printer enters
power save mode when it is idle for a specified length of time
(15 minutes by default). While in this mode, the printer
conserves energy by using less electricity.

Power save mode is automatically interrupted whenever you
send a print job or press the reset button at the back of the
printer. It takes approximately 45 seconds for the printer to
warm up when it is in power save mode.

You can specify how long the printer is idle before power save
mode comes on or turn off power save mode. For more
information, see Chapter 2.
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Monitoring the Printer Status

If you are running Windows, the printer keeps you informed of
its status in two ways:

The Ready and Error lights on the front panel come on or
flash depending on the current status. For example, the
Ready light begins to flash as data is sent from your
computer to the printer.

The EPSON Control Panel for Windows automatically
presents screens to keep you informed of the printer status
or notify you of an error. For example, each time the paper
tray is empty, a screen automatically appears to inform you
of the change in status.

Note:
If you are running the EPSON Control Panel for DOS, the Reporter
provides onscreen status and error messages to keep you informed of
the printer status.

Front panel lights

The two lights on the front panel allow you to monitor the
status of the printer. The green Ready light is on when the
printer is on and is ready to receive print data. As data is
received from the computer, the Ready light flashes.

The orange Error light indicates an error condition. If the Error
light is on continuously, it indicates that no paper is loaded or
that there is a paper feed jam. A flashing Error light indicates
one of the following: an internal paper jam has occurred, the
front cover is open, or the toner cartridge is not installed.
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Other status conditions are indicated by the combination of the
Ready and Error lights. The following table describes all status
conditions that can be indicated by the printer’s Ready and
Error lights:

Ready Error

o f f Off

Slow Off
flashing

F l a s h i n g  O f f

Printer status

Printer is off.

Printer is in power save mode.

Print data is being received at the printer or has
already been received.

On

off

off

On

Printer is ready to receive print data.

Either the paper tray is empty or there is a
paper feed problem.

off Flashing One of the following errors has occurred:
• Paper has jammed inside the printer.
• The front cover is open.
• The toner cartridge is not installed.

F l a s h i n g  O n One of the following errors has occurred:
• Insufficient memory to print job.
• Printer is In manual feed mode and is waiting

for the next sheet.
• There is a printer overrun error.

Flashing Flashing

On On

The printer is warming up.

A printer engine or controller error has
occurred. Contact your dealer or a qualified
service person.

The EPSON Control Panel provides more precise information
about the printer status or any errors that occur. See the next
section.
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EPSON Control Panel for Windows

The EPSON Control Panel for Windows consists of a series of
screens that appear automatically whenever the printer status
changes and whenever the printer encounters an error. For
example, EPSON Control Panel messages appear in the
following cases:

The paper tray is empty.

The printer is warming up.

A print error has occurred. For each error, an EPSON
Control Panel message informs you of what you can do to
correct the problem.

The message remains open on top of your software program
until you minimize the screen by clicking the Minimize button
(    ) in the upper right comer of the message window. To
make the EPSON Control Panel message window reappear,
double-click the EPSON Control Panel icon at the bottom left
comer of your screen.

Note:
If you are using the EPSON Control Panel for DOS, the Reporter
provides on screen status and error messages to keep you informed of
the printer status.
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Paper Handling
The paper tray holds up to 100 sheets of various standard-size
papers, including letter and legal. For other sizes and exact
specifications, see Appendix A.

Loading paper

To load a stack of paper in the printer’s paper tray:

1. Remove any paper remaining in the paper tray. Do not add
paper to a partial stack.

2. Pull the paper release lever toward the front of the printer.

3. Fan a stack of paper and load the paper in the paper tray.
Place the paper side you want printed face down in the
paper tray. Up to 100 sheets can fit in the paper tray.

4. Slide the paper guides against the paper stack so the paper
fits loosely between them. The paper guides should not fit
too tightly against the paper.
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5. Push the paper release lever toward the back of the printer.

This places the feed roll in contact with the paper stack.
Paper will not feed properly if the paper release lever is not
in the feed position.

For information about loading heavy paper, envelopes, labels,
or transparencies, see “Printing on special paper” later in this
chapter.

Choosing paper

For best results, use paper made especially for laser printers
or plain-paper copiers. Paper should be of good quality and
relatively smooth with a weight between 16 and 24 lb (60 and
90  g/m²). Because the printer is sensitive to moisture, always
store paper in a dry place.

You may use colored paper but not paper to which a clear or
colored coating has been added. For preprinted paper stock
such as letterheads, use papers and inks designed for laser
printers. Ordinary inks or dyes may smear or come off when
subjected to the high temperature of the fuser. Always test
samples of paper stock before purchasing large amounts.

Note:
The quality of any particular brand or type of paper may be changed
by the manufacturer at any time, so EPSON cannot guarantee any
particular one.

In addition, you can print on special stock such as heavy
paper (greater than 24 lb or 90 g/m2), envelopes, labels, or
transparencies. To do so, you need to feed single sheets one at a
time. See the next section "printing on special paper.”
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Printing on special paper

You can print on special paper stock such as heavy paper
(over 24 lb or 90 g/m2), envelopes, labels, and transparencies.
When selecting special types of paper or other stock, follow the
recommendations given below.

For printing on special paper, it is usually easier to use manual
feed and feed a single sheet at a time. To use manual feed,
select the printer driver’s Manual Feed option and turn off
Auto Continue (see Chapter 2 for information on printer driver
settings). Then send your print job. The printer prints the page
and then waits for you to press the reset button at the rear of
the printer before it prints the next sheet.

Envelopes

Toad envelopes with the flap-side up and to the left. The
printing quality on envelopes may be irregular because
different parts of an envelope have different thicknesses. Print
one or two envelopes to check the print quality. If the printing
is too light, adjust the print density as described in Chapter 3.

Do not use envelopes with metal clasps or fastenings. Also do
not use window envelopes unless they are specially designed
for laser printers. The plastic on most window envelopes can
melt when it comes in contact with the hot fuser.

Labels
Use only labels designed for laser printers or plain-paper
copiers. To prevent the adhesive from coming into contact with
printer parts, always use labels that completely cover the
backing sheet, with no gaps between the individual labels. You
should test the label sheet for leaking adhesive by pressing a
sheet of paper on top of a sheet of labels. If the paper sticks, do
not use the labels.
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Transparencies

You can use overhead projector transparencies and adhesive
drafting film if they are made for use with laser printers or
plain-paper copiers. Normally you should use manual feed
when printing transparencies.

Fonts

The printer comes with a set of 14 bitmap and 8 scalable
resident fonts. The resident bitmap fonts include Courier and
Line Printer in various sizes and orientations. The resident
fonts, stored permanently in memory, are these:

CG Times Medium Univers Medium
CG Times Bold Univers Bold
CG Times Italics Univers Italics
CG Times Bold Italic Univers Bold Italic

All other Windows fonts are automatically transferred, or
downloaded, from the computer to the printer when you send
a print job. For other types of fonts to be downloaded, you
need the appropriate screen font software. For example, to
download Adobe® fonts, you need Adobe Type Manager™
(ATM); to download Intellifont® Scalable Typefaces from Agfa,®

you need Intellifont for Windows.” If you don’t have the
appropriate screen font software for a particular font, the font
will not be downloaded and the printer will substitute one of
the resident fonts.

Downloaded fonts remain in printer memory only until the
print job is completed. When the print job is completed or you
turn off the printer, downloaded fonts are flushed from
memory. Downloaded fonts, which must first be transferred
from the computer, do not print as fast as resident fonts.
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If you are printing a page that consists mainly of graphics but
not a lot of TrueType text, you might want to print TrueType as
graphics as described in Chapter 2. Printing TrueType fonts as
graphics requires less printer memory and may speed up
printing because the fonts don’t need to be downloaded.
Printing TrueType as graphics is also useful if you want to
print graphics over text so that only a portion of the text is
visible.
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Changing the Printer Settings

In Windows-based software programs, you use the Print dialog
box, which is accessible through the File menu, to specify the
most common printer settings, including the number of copies,
print range, and orientation.

Note:
If you are not running Windows, you control printer setting through
the EPSON Control Panel for DOS. See Appendix B for more
information.

The printer driver that comes with the ActionLaser 1100 allows
you to control additional settings to do the following:

Turn power save mode on and off and specify how long the
printer is idle before entering power save mode

Turn on toner saving mode and specify what level of toner
saving to use

Adjust the edge smoothing feature

Control the toner density

Other settings are described later in this chapter.

Note:
If you are using Microsoft Windows, you can also control the printer
through the Printers icon in the Control Panel. Double-clicking on
the Printers icon brings up a dialog box that allows you to install and
select the printer driver, change the printer’s interface port, and
control the printing of your files. Normally you need to use the
Printers icon only when you first set up the printer. See your
Windows manual for more information.
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Accessing Printer Driver Settings in Windows

If you’re using a Windows-based software program, you access
the printer driver settings through the Setup dialog box.

The way in which you access the Setup dialog box for the
ActionLaser 1100 differs slightly, depending on your software
program.

First choose Print or Page Setup in the File menu of your
software program. This opens a dialog box.

You now need to select another option. Depending on your
software program, you need to choose the Setup, Options, or
Printer button Some programs then prompt you to select the
ActionLaser 1100 before the Setup screen appears.
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Printer Driver Settings

The printer driver settings fall into three categories:

Print settings that determine how your print job is printed.
These settings, which are included on the Setup dialog box,
include the number of copies, orientation, and resolution
used for printing graphics. The way in which printer
memory is allocated can also be specified.

Option settings that include toner saving and power save
modes, the edge smoothing setting, and the type of
halftone pattern to apply to grayscale images. Option
settings are accessible by choosing the Options button in
the setup dialog box.

Font Manager settings that allow you to copy PCL® fonts to
your computer’s hard disk. The Font Manager is accessible
by choosing the Fonts button in the Setup dialog box.

Print settings

The Setup dialog box contains the settings described below.

Auto Continue

Permits the printer to automatically recover from printer
overrun and memory overflow errors and continue
printing. By default, Auto Continue is on. To use manual
feed, turn Auto Continue off. If a printer overrun or
memory overflow error occurs while Auto Continue is off;
press the reset button to resume.
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Paper Size

Specifies the size of paper loaded in the paper tray. Select
one of the following paper or envelope sizes:

Letter (default)
Legal
A4
Executive
COM-10 envelope
Monarch envelope
DL envelope
C5 envelope
B5 envelope

8.5 x 11 inches
8.5 x 14 inches
210 x 297 mm
7.25 x 10.5 inches
4 1/8 x 9.5 inches
3 7/8 x 7.5 inches
110 x 220 mm
l62 x 229 mm
176 x 250 mm

Paper Feed

Specifies whether paper or envelopes are fed automatically
from the paper tray or whether paper is fed manually. The
options for Paper Feed are Automatic (default), Manual,
and Envelope.

By default, Automatic is selected and the printer uses the
paper in the paper tray and prints pages continuously as
long as print data is received from the computer.

Use the Manual setting when you want to feed a single
sheet at a time, such as when you are printing on heavy
paper, labels, or transparencies. See “Printing on special
paper” in Chapter 1 for more information about manual
feed. Use the Envelope setting if you are printing on
envelopes; when using Envelope feed, be sure to specify
the appropriate Paper Size setting for the type of envelope
(COM-10 is the default).

Manual and Envelope stay active only until you exit
Windows. Each time you start Windows, the paper feed is
reset to the default (Automatic).
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Graphics Resolution

Specifies what resolution to use to print graphics. Note
that Graphics Resolution does not affect text. The options
for Graphics Resolution are 300 dpi (default), 150 dpi, and
75 dpi.

Normally you should print at 300 dpi, which produces the
best looking graphics. The output quality decreases for the
150- and 75-dpi resolutions.

However, if the printer does not print the entire graphic
on one page and you receive a memory overflow message,
reduce the graphics resolution to 150 or 75 dpi. Printing at
a lower resolution is also faster than printing at 300 dpi.

If you often encounter memory overflow problems, you
should also turn on Image Compression, which is described
later in this chapter, or add more memory to your printer.
See Appendix D for more information about adding
memory.

Copies

Specifies how many uncollated copies to print. This option
is provided in case your software program does not allow
you to specify the number of copies. Normally you should
use the Copies command from the Print menu to specify
the number of copies.

You can enter any number from 1 to 999. The default is 1.

Memory

Defines the amount of memory installed in the printer.
Windows uses this information to determine the amount
of memory you have available for printing.
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The Memory setting should exactly match the total amount
of memory in your printer. If you add more memory to the
printer, you need to change the Memory setting to match
the amount of printer memory. The additional memory
will not be available unless the Memory setting is correct.

If you are unsure how much memory is installed in your
printer, print a test page by pressing the reset button at the
back of the printer. (Pressing the reset button prints a test
page only if the Ready light is on and the Error light is off.)
The amount of memory (RAM) is stated in KB on the test
page.

Memory can be 1,2,3,4, or 5MB. The default is 1MB.

Page Protection

When Page protection is enabled, the printer reserves
additional memory and does not print a page until the
entire page is fully composed. This allows the printer to
print complex pages that can otherwise cause printer
overrun errors.

The settings for Page Protection are Off, On, and Automatic
(default).

You do not normally need Page Protection However, if
the printer receives an unusually complicated page that
contains a complex image or layout, it might start to print
the page before the processor can finish imaging it,
resulting in the page printing incorrectly.

If you turn on Page Protection, the printer reserves printer
memory and does not begin printing until the processor
has finished imaging the entire page. The page then prints
correctly, although it takes slightly longer to print.
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When Auto is selected, the printer first analyzes each
page. If a page is complex, Page Protection is turned on
automatically; otherwise, it is not used.

If you continue to encounter page overrun errors even
when Page Protection is on, you might want to add more
printer memory. See Appendix D for more information.

image Compression

Specifies that the printer first compress raster images
before printing them. This allows you to print graphics-
intensive pages using less memory.

Turn Image Compression on if you receive memory
overflow errors and are not able to print pages that contain
a lot of graphics. Graphics require more memory than text;
for large or complex graphics, the printer might not have
enough memory to correctly print the page. Image
Compression compresses the image into a small amount of
printer memory. The tradeoff is that your page may not
look as detailed as it would when printed without image
compression.

If you continue to encounter memory overflow errors even
when Image Compression is on, you might want to add
more printer memory. See Appendix D.

Orientation

Specifies whether the page is printed in portrait or
landscape orientation. In portrait orientation, the top of the
page is parallel to the short edge of the page. In landscape
orientation, the top of the page is parallel to the long edge.

Normally you should select print orientation from the Print
dialog box.
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Option settings

When you choose the Options button of the Setup dialog box,
the following dialog box appears:

Gray Scale

Specifies what halftone pattern to apply to grayscale
images. The options are Photographic Images (default),
Line Art Images, and Scanned Images. Each option is
described below. The best way to choose a setting for your
images is to experiment. Print a grayscale image at each
setting and choose the one you like best.

Choose Photographic Images for images that you want to
have a smooth, realistic appearance. This setting provides
soft contrasts between shades of gray and works well for
images originally designed with color. When Photographic
Images is selected, the printer uses an 8 bit-by-8 bit
“clustered dot” method to emulate 64 levels of gray.
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Choose Line Art Images for images with intricate lines
and fine detail, such as clip art images. This setting
provides solid lines and sharp contrasts between shaded
areas. When Line Art Images is selected, the printer uses
8 bit-by-8 bit “dispersed dot” patterns to produce 32 gray
tones.

Choose Scanned Images for images that were originally
scanned. In this setting, the printer uses a variation of
the 8 bit-by-8 bit “clustered dot” method used in the
Photographic Images setting. This method also produces
64 different levels of gray.

Print TrueType as Graphics

Specifies that TrueType fonts be printed as graphics.

You might want to print TrueType fonts as graphics if
your document contains a lot of graphics but not a lot of
TrueType text. In this case, printing TrueType fonts as
graphics requires less printer memory and may speed up
printing.

This setting is also useful if you want to overlay graphics
on top of text.

Toner Saving

Allows you to use less toner when printing draft
documents. This can reduce your printing costs because
you need to replace toner cartridges less often. Toner
Saving can be one of the following: Light, Medium, Dark,
or Off (default).

The Light setting uses the least amount of toner, and the
Dark setting produces the most legible output while still
saving toner.

Setting Toner Saving to Off results in normal output and
toner usage.
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Edge Smoothing

Allows you to adjust the edge smoothing feature or turn it
off. Edge smoothing improves the appearance of text and
graphics by smoothing the jagged edges of characters and
line art, resulting in higher quality output. For more
information about edge smoothing, see chapter 3.

The settings for Edge Smoothing are Light, Medium
(default), and Dark Normally you should not have to
adjust Edge Smoothing.

However, because edge smoothing modifies the size of
dots along the edges of text, lines, and graphics, the edges
might appear too dark or too light To adjust for this, use
the Light setting if the edges appear dark, and use the Dark
setting if the edges appear too light.

Toner Density

Specifies the density of the toner applied to the page.
Normally, you should not need to adjust this setting. It is
provided to allow you to compensate for variations among
toner cartridges.

The settings for Toner Density are Extra Light, Light,
Medium (default), Dark, and Extra Dark

Note:
Increasing the density increases the rate of toner consumption.
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Power Save Mode

Specifies whether power save mode is on or off.

When Power Save Mode is on, the printer uses less
electricity by entering a low-power state when the printer
is idle for the length of time specified by Power Save
Interval. When the printer is in the low-power state, it takes
approximately 45 seconds for the printer to warm up once
it receives data.

In compliance with the Energy Star program, Power Save
Mode is factory-set  to on.

Power Save Interval

Specifies how long the printer is idle before it enters power
save mode. Power Save Interval can be any value from 1 to
999 minutes. The default is 15 minutes.

Power Save Interval is valid only when Power Save Mode
is on.

Font Manager

The Font Manager, accessible by choosing the Fonts
button of the Setup dialog box, allows you to install
XL-compatible fonts to your hard disk. You need to use
Font Manager only to install PCL-compatible fonts.
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Resetting the Printer

In many cases, you can recover from a problem, such as a print
overrun or a memory overflow, by briefly pressing the reset
button at the rear of the printer. This clears the error so the
printer can resume printing.

You can also reset the printer to clear its memory of any print
jobs currently in memory and to return to the factory defaults.
To reset the printer, hold down the reset button at the back of
the printer for five seconds. Be aware that your software
settings override the default settings.

General Problems

This section describes some general problems you may
encounter and gives some suggestions on how to avoid them.

Preventing paper feed and paper jam problems

If you have frequent paper feed or paper jam problems, use this
checklist of corrective measures:

Use a higher-quality paper that is not too thin or rough.
Some types of paper require single-sheet feeding. See
“Paper Handling” in Chapter 1.

Be sure to pull the paper release lever toward the front of
the printer before installing paper. After paper is installed,
push the lever back.

Always remove any paper remaining in the paper tray
before you load paper. Do not add more paper when paper
is already loaded.

Fan the stack of paper and then tap it on the edge to align it
before loading.
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Be sure the printer is level.

Do not load more than 100 sheets of paper in the tray.

Be sure to adjust the paper guides so that the paper can
slide in and out freely.

Never let more than 50 sheets accumulate in the exit tray.

Try turning over the stack of paper in the tray. Most paper
packages indicate which side should be face up.

Do not load paper while the printer is operating.

The Ready light does not turn on when you turn the printer on

Open the printer’s front cover and make sure the toner
cartridge is installed securely.

Turn off the printer and check the power cable connections
between the printer and the electrical outlet; then turn the
printer back on.

If the electrical outlet is controlled by an outside source such
as a wall switch, make sure the switch is turned on or plug
another electrical device into the outlet to make sure the outlet
is operating properly.

The Ready light is on but nothing prints

Your computer may not be properly connected to the printer.
Perform the procedure “Testing the computer-toprinter
connection” in the Read This First guide.

The interface cable may not be plugged in securely. Check both
ends of the cable between the printer and the computer. Be
sure to secure the connector using the wire retaining clips.
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Make sure that your interface cable is shielded.

The toner cartridge may be empty. Replace the toner cartridge
as described in the Read This First guide.

A single sheet or the last sheet doesn’t print

The file you sent might not contain a form feed command.
(The printer won’t print a single page or the last page of a
multi-page document unless the file ends in a form feed
command.) To print the single sheet or the last sheet, briefly
press the reset button at the back of the printer.

Some or all of the output is garbled or printed as asterisks

Make sure that both ends of the interface cable are plugged
in securely.

Make sure your interface cable is shielded.

If the printer still does not print correctly, call your dealer or a
qualified service person.

Position of the printout is not correct

Make sure that you are using the correct page length and
margin settings in your software program.

Graphics don’t print correctly

Make sure that your software program supports the LJ3
emulation.

Graphics require large amounts of memory; if you are
encountering problems because of insufficient memory,
simplify your graphics or use fewer graphics on a page. If
you often print graphics-intensive pages, you may want to
add more memory as described in Appendix D.
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The font you selected in your software program doesn’t print

The font you selected in your software program is not a
Windows font and cannot be downloaded. To download
non-Windows fonts, you need to obtain the font screen
software appropriate for the type of font (e.g., ATM, Intellifont
for Windows).

Print Quality Problems

Dark or dirty background

Turn off the printer. Clean the paper path inside the printer
using a clean, soft, dry cloth.

Clean internal printer components by printing three pages with
only one character per page.

There may be a problem with the toner cartridge. Remove the
cartridge, shake it gently from side to side, and then reinstall it.
If this does not solve the problem, replace the toner cartridge as
described in the Read This First guide.

Change the Density setting to light print. See “Adjusting print
density” later in this chapter.

Vertical black or white bands or lines

Install a new toner cartridge as described in the Read This First
guide and print several pages to check the print quality.
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Horizontal black or white bands or black page

Install a new toner cartridge as described in the Read This First
guide.

Uneven darkness

Your paper may be moist or damp. Printing is sensitive to
moisture absorbed by the paper. Do not store your paper in a
humid or damp environment.

Take out the toner cartridge, shake it gently from side to side,
and then reinstall it.

If this does not solve the problem, install a new toner cartridge
as described in the Read This First guide. Then print several
pages to check the print quality.

Toner smudges

Remove the toner cartridge, shake it from side to side to
distribute the toner, and wipe the bottom of it with a clean, dry
cloth.

Turn off the printer. With the toner cartridge removed, clean
the paper path inside the printer using a clean, soft, dry cloth.
Be sure to clean the laser scanner window, which is located
immediately in front of the orange strip at the bottom of the
printer interior.

Clean internal printer components by printing three pages with
only one character per page.

If the problem remains, replace the toner cartridge as described
in the Read This First guide.
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Missing areas on printed image

Your paper may be moist or damp. Printing is sensitive to
moisture absorbed by the paper. The higher the moisture
content in the paper, the lighter the printed output. Do not
store your paper in a humid or damp environment.

You may not be using the correct type of paper for your
printer. If the surface of your paper is too rough, printed
characters appear distorted or broken. Smooth, high-quality
copier paper is recommended for best results. See Chapter 1
for information on choosing paper.

Completely blank pages

Check to be sure the toner cartridge is installed as described in
the Read This First guide.

The toner cartridge may be empty. Replace the cartridge.

The problem may be with your software program or interface
cable. Print out a test sheet by briefly pressing the reset button
on the back of the printer (make sure the Error light is not on).
If the test page is blank, the problem is with the printer. Call
your dealer or a qualified service person.

Printed image is light or faint

The toner cartridge is probably empty. Replace the toner
cartridge as described in the Read This First guide.

Your paper may be moist or damp. Printing is sensitive to
moisture absorbed by the paper. The higher the moisture
content in the paper, the lighter the printed output. Do not
store your paper in a humid or damp environment.
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Take out the toner cartridge, shake it gently from side to side
to distribute the toner, and then reinstall it. If the problem
persists, replace the toner cartridge as described in Read This
First.

Use the printer driver’s Density item for darker print. See
“Adjusting print density” later in this chapter.

Image is too dark

Use the printer driver’s Density item for lighter print. See
“Adjusting print density” later in this chapter. If the problem
persists, replace the toner cartridge as described in Read This First.

Non-printed side of the page is dirty

Toner may have spilled in the paper feed path. Turn off the
printer. Remove the toner cartridge and then clean the paper
path of the printer using a clean, soft, lint-free cloth. Be sure to
clean the laser scanner window, which is located immediately
in front of the orange strip at the bottom of the printer interior.

Optimizing Print Quality

If the quality of your printouts is not good, read the following
sections for information on enhancing the print quality.

Adjusting edge smoothing

The edge smoothing feature improves the appearance of text
and graphics by smoothing the jagged edges of characters and
line art, resulting in higher quality output.

The settings for the printer driver’s Edge Smoothing setting are
Light, Medium (default), and Dark
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Normally you should not have to adjust the Edge Smoothing
setting. However, because Edge Smoothing modifies the size
of dots along the edges of text, lines, and graphics, the edges
might appear too dark or too light relative to the area inside the
edges.

To adjust for this, use the Light setting if the edges appear
dark, and use the Dark setting if the edges appear too light.

To change the Edge Smoothing setting:

1. From your software program, choose Print or Print Setup in
the File menu.

2. Then choose the Setup option (Depending on your
software program, you might need to select Options or
Printer.)

3. If necessary, select the ActionLaser 1100 in the list of
printers. (Not all software programs prompt you to select
the printer.)

4. In the Setup dialog box for the ActionLaser 1100, choose the
Options button.

5. Change the Edge Smoothing setting as appropriate.

6. Choose OK. Then close all screens by choosing OK or Close
as appropriate.

If your printed images still need to be improved, you probably
need to change the print density setting. For a darker edge
smoothing setting, make the print density lighter and vice
versa. See the next section, “Adjusting print density.”

Note:
Edge smoothing may not improve graphics that include gray shading
or a screen pattern. If you are printing gray shading or screen
patterns, you might want to change the Edge Smoothing setting to off.

Troubleshooting 3-9



Adjusting print density

Note:
Do not change the print density unless it is necessary. Changing the
print density affects all text and graphics, so check the new setting by
printing several pages with various kinds of text and graphics.

If your printed pages are too light or too dark, adjust the print
density as follows:

1.

2.

3.

4.

5.

6.

From your software program, choose Print or Print Setup in
the File menu.

Then choose the Setup option. (Depending on your
software program, you might need to select Options or
Printer.)

If necessary, select the ActionLaser 1100 in the list of
printers (Not all software programs prompt you to select
the printer.)

In the Setup dialog box for the ActionLaser 1100, choose the
Options button.

Change the Toner Density setting as appropriate.

Choose OK. Then close all screens by choosing OK or Close
as appropriate.

Note:
Increasing the print density increases toner consumption. If you
select darker print, you may need to replace the toner cartridge more
often.
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Cleaning the Printer

The printer needs only minimal cleaning. If you notice a
decline in print quality, clean the inside of the printer as
described in this section. You should also clean the printer’s
outer case every few months.

Whenever you clean the printer or replace the components,
print a test sheet by pressing the reset button at the back of the
printer.

Cleaning the inside of the printer

Fine particles of paper dust and ordinary dust can collect inside
the printer. Follow the steps below to clean the inside of the
printer:

1. Make sure the printer is turned off.

2. Open the printer’s front cover.

3. Remove the toner cartridge.

4. Remove any dirt inside the printer with a soft, clean cloth.
Do not use compressed air.
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Be sure to clean the laser scanner window at the bottom area
inside the printer. This window is located immediately in
front of the orange strip at the bottom of the printer interior.

5. Reinstall the toner cartridge.

6. Close the front cover.

7. Remove any pages and clean the paper tray with a soft cloth.

Removing spilled toner

If toner spills inside the printer, do not use the printer until you
remove all the spilled toner. Follow these steps:

1. If only a small amount of toner is present, carefully wipe out
the inside of the printer with a clean, dry cloth. Be sure to
clean the laser scanner window, which is located immediately
in front of an orange strip at the bottom of the printer interior.

2. If a large amount of toner is present, use a small vacuum
cleaner (available from computer supply stores) to remove
it. Then carefully wipe with a clean, dry cloth.

Caut ion:

Toner or any other fine powder can damage some vacuum
cleaners. Be sure to read the instructions for your vacuum
cleaner before you use it on spilled toner.

Note:
If you spill toner on your clothing, rinse it off  with cold water. Do not
use hot water; it may cause the toner to leave a permanent stain.
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Cleaning the printer case

If the printer’s outer case is dirty or dusty, turn off the printer and
clean it with a soft, clean cloth dampened with a mild detergent.

Caution:
Never use alcohol or thinner to clean the printer’s outer case;
these chemicals can damage the components and case. Be
careful not to get water on the printer mechanism or any
electronic components.

Deleting the EPSON Control Panel for Windows

If you need to delete the EPSON Control Panel for Windows,
do the following:

1.

2.

Turn on the computer and start Windows.

From the Program Manager, choose Run in the File menu.
This brings up the Run dialog box.

3. In the Command Line text box, type C:\EPPRT\EPDELETE.

Note:
If the EPSON Control Panel is in a directory other than the
default EPPRT directory, be sure to specify the correct pathname.

4. When you are asked if you want to delete the EPSON
Control Panel, choose OK.

5. Once the EPSON Control Panel is deleted, a message
appears telling you to delete EPDELETE.EXE. Choose OK.

6. Use the File Manager to delete EPDELETE.EXE from the
C:\EPPRT directory. Then delete the EPPRT directory.

Troubleshooting 3-13



Appendix A
Technical Specifications

Paper . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Paper specifications . . . . . . . . . . . . . . . . . . . . . . .

Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Environmental . . . . . . . . . . . . . . . . . . . . . . . . . .
Mechanical . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Electrical . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Toner cartridge . . . . . . . . . . . . . . . . . . . . . . . . .

Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

A-2
A-2

A-3
A-3
A-4
A-4
A-4
A-5

A-6

Technical Specifications A-1



Paper

Paper specifications

Note:
Since the quality of any particular brand or type of paper may be changed by the
manufacturer at any time, EPSON cannot guarantee the use of any particular
brand or type of paper. Always test samples of paper stock before purchasing large
quantities or printing large jobs.

Paper types:  Plain paper
 Special paper
 Labels
 Envelopes
 Transparencies

 Colored paper

Paper weight:

Paper size:

Plain paper: 16 to 24 lb, 60 to 90 g/m2

Card stock: 24 to 32 lb, 90 to 120 g/m2

(single-sheet feed only)

Paper:

Envelope:

Type Size
Letter 8.5 x 11 inches

Legal 8.5 x 14 inches
Executive 7.25 x 10.5 inches
A4 210 mm x 297 mm

B5 176 mm x 250 mm
Monarch 3 7/8 x 7 1/2 inches
Commercial 10 4 1/8 X 9 1/2 inches
DL 110 mm x 220 mm
C5 162 mm x 229 mm

Caution:
Do not load any size of paper other than those listed above.

Printable area: 4 mm from paper edge
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Paper feed
Paper feed
alignment and
direction:

Paper feed:

Input paper supply
(20 lb paper):

Paper eject:

Output tray
capacity
(20 lb paper):

Printer

General

Printing method:

Resolution:

Printing speed:

Warm-up time:

Internal emulation:

Resident fonts:

CPU:

RAM:

Center alignment for all sizes

Automatic or manual feed

100 sheets
5-10 envelopes, depending on thickness

Face down

50 sheets

Laser beam scanning and dry
electrophotographic process

300 x 300 dpi

Up to 4 pages per minute depending on the font
and quantity of data

Approximately 45 seconds

HP LaserJet III emulation

14 bitmap and 8 scalable fonts
(See Chapter 1 for a list of resident printer fonts.)

68HC000, 16 MHz

1MB, expandable up to 5MB
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Environmental

Temperature:

Humidity:

Altitude:

Mechanical

Dimensions
weight:

Durability:

Electrical

Voltage!:

Rated frequency:

Rated current:

Power:

Safety
standards:

Laser radiation
regulations:

EMI:

operatim: 5 to 35°C (42 to 95°F)
Storage: -20 to 40°C (-4 to 104°F)

Operation: 15 to 85% RH
storage: 5 to 95% RH

2500 meters (8200 feet) maximum

Height: 10.5 inches (265 mm)
Width: 13 inches (330 mm)
Depth 9-25 inches (235 mm)
Weight:  Approx. 11 lb (5 kg) including the

toner cartridge.

5 years or 100,000 sheets, whichever comes first

90 V to 132 V

50 Hz to 60 Hz ±  3 Hz

Approximately 3.2 amps

Approximately 400W
Powers down to less than 30W in power save
mode

UL 1950
CSA 22.2 No. 950 Deviation 3

FDA (NCDRH) Class 1

FCC Part 15 Subpart B, Class B
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Toner cartridge

Model number:

Storage
temperature:

Storage humidity:

shelf life:

Life:

S051023

0 to 35°C (32 to 95°F)

15 to 85%RH

24 months after production

Up to 4000 pages under the following conditions
Letter-size paper, continuous printing, and
5% print ratio.

The number of pages you can print with a toner cartridge varies
depending on the type of printing. If you print  a few pages at a time or
print dense text exceeding the 5% print ratio, your cartridge may print
fewer pages. The 5% print ratio is equivalent to double-spaced standard
text.

You can increase the life of the toner cartridge by using toner saving
m o d e .

Technical Specifications A-5



Inferface

The parallel interface connector pin assignments and a description of the
interface signals are shown in the table below.

Signal Return
Pin Pin Signal Direction Description

1 19 STROBE IN STROBE pulse to read data.
Pulse width must be at least
0.5 µs at the receiving
terminal.

2 20 DATA 1 IN These signals represent
3 21 DATA 2 IN parallel data bits 1 to 8,
4 22 DATA 3 IN respectively. Each signal is at
5 23 DATA 4 IN HIGH level when data is
6 24 DATA 5 IN logical 1 and LOW when it is
7 25 DATA 6 IN logical 0.
8 26 DATA 7 IN
9 27 DATA 8 IN

10 28 ACKNLG OUT About a 1-10-µs pulse width.
LOW indicates data has
been received and the
printer is ready to accept
more data.

11 29 BUSY OUT A HIGH signal indicates that
the printer cannot receive
data. The signal goes HIGH in
the following cases.
1. During printing
2. During a printer-error state

12 30 PE OUT A HIGH signal indicates the
printer is out of paper

13 — SLCT OUT Pulled up to +5v through
3.3 resistance.

1 4 — A U T O IN Not used
F E E D

15 — NC — Not used

16 — G N D — Logic ground level

17 CHASSIS — Printer's chassis ground,
GND wh ich  i s  connec ted  t o  t he

s igna l  g round .

18 — N C — Not used

A-6 Technical Specifications



Signal Return
Pin Pin Signal Direction Description

19-30 - GND - Twisted-pair return signal
ground level.

31 - NC - Not used

32 - ERROR OUT This signal level goes LOW
when the printer is:
1, Out of paper
2. In on error state

33 - GND -

34 - NC -

35 - +5v -

36 - SLCTIN IN

Some as for Pins 19-30

Not used

Pulled up to +5 V through
3.3        resistance.

Available only for
bidirectional use.

Note:
All interface conditions are based on TTL level. Both the rise and fall times of
each signal must be less than 0.2 microseconds.

Data transfer must be carried out by observing the ACKNLG or BUSY
signal. (Data transfer to this printer can be carried out only after receipt of
the ACKNLG signal or when the level of the BUSY signal is LOW.)

The column heading “Direction“ refers to the direction of signal flow as
viewed from the printer.

Return denotes the twisted-pair return to be connected at signal ground
level. For the interface wiring, be sure to use a twisted-pair cable for each
signal and to complete the connection on the return side.

The ACKNLG puke width varies.
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EPSON Control Panel for DOS

If you are not running Microsoft Windows, you can control printer
settings through the EPSON Control Panel for DOS. This onscreen utility
consists of five screens that allow you to do the following:

Change page setup settings, such as the number of copies,
orientation, and page size.

Select a font, point size, or symbol set.

Control the print quality by specifying the edge smoothing, toner
saving, and toner density settings.

Control how printer memory is used by turning page protection or
image compression on or off.

Turn the power save option on or off and specify how long the
printer is idle before power save mode turns on.

Most of the settings available in the EPSON Control Panel for DOS are
the same as the printer driver settings available for Windows. For a
description of the individual printer settings, see Chapter 2.

Some settings, such as those for page setup and font selection, are also
available through your software program. Whenever possible, change
settings in your software program rather than in the EPSON Control
Panel for DOS. Not only is it more convenient but the settings in your
software program override settings in the EPSON Control Panel for DOS.

Note:
You cannot run the EPSON Control Pane  for DOS from Windows.

Installation

1. Insert the EPSON Control Panel for DOS disk in a floppy drive.

2. From a DOS prompt, change to the floppy drive by typing A: or B: as
appropriate. Press Enter.

3. Type SETUP and press Enter. After a few moments, the initial setup
screen appears.

4. Read the information on the setup screen. Then press Enter to
continue.
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5. The screen displays the default setup parameters that are designed to
be used for most computer environments. If the default parameters
are acceptable and you don’t need to make any changes, press Enter.

If you need to make changes, tab to NO and press Enter. This brings
up a series of screens, each of which prompts you to change a setting.
For each setting, press Enter to accept the default or change the
setting and press Enter. The setup program begins uncompressing
files and copying them to your hard disk.

6. When a message appears telling you that installation was successful,
press Enter to exit the setup program.

This completes installation of the EPSON Control Panel for DOS.

To print using your printer, you need to select the HP LaserJet III printer
driver in your software program If the LaserJet III driver is not available,
contact your software manufacturer for an updated version of the
software program Until you receive the new version, you can use any
LaserJet II driver or any driver that uses HP PCL.

See your software manual for specific information on how to select a
printer driver.

Bringing up the EPSON Control Panel for DOS

To bring up the EPSON Control Panel for DOS, do the following

1. At a C: prompt, change to the PANEL directory by typing
CD \PANEL. Then press Enter.

Note:
If you installed the EPSON Control Panel to a different directory than the
default, be sure to specify the correct pathname.

2. Type PANEL and press Enter.
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Using the EPSON Control Panel for DOS

The interface for the EPSON Control Panel for DOS consists of three parts:
the current screen, a menu bar, and screen buttons for accessing other
screens.

EPSON Control Panel screens

The EPSON Control Panel for DOS consists of five screens: Page Setup,
Font, Quality, Memory, and Options. One screen is displayed at a time,
and the other screens are represented by buttons to the left of the current
screen.
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The five screens are listed below, along with the items available on each.

Menu

Page Setup

item
copies
Lines per Page
Orientation
Paper Feed
Paper Size
Auto Continue

Font Typeface
Point
Symbol Set

Quality Toner Saving
Edge Smoothing
Toner Density

Memory Page Protection
Image Compression

Options Power Save Mode
Power Save Interval

Moving within and between screens

When you first bring up EPSON Control Panel for DOS, the Page getup
screen is displayed. If you want to change an item in the current screen,
use the Tab key to move to the item you want to change. Then use the up
and down arrows to select a new setting for the item. Press Tab to apply
the new setting and move to the next item.

To access another screen, hold down the Alt key and press the letter that
is underlined on the screen button. For example, to open the Font screen,
press Alt + N. To move from the screen button to the currently displayed
screen, press Tab.

Once you make changes to the settings, choose OK to save the changes
and update the printer. To cancel your changes and return to the original
settings, choose Cancel. (If you exit the screen without choosing OK or
Cancel, you are prompted to save or to cancel changes when you exit the
EPSON Control Panel.)
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Menu bar

The menu bar contains the following four menus:

File The File selections allow you to exit the utility,
save printer settings as a profile, retrieve a
previously saved profile, and export a profile to
the printer. For more information about profiles,
see the following section.

View Choosing View brings up a listing of the current
printer settings.

Utility The Utility selections allow you to reset the
printer, change the port setting, and print a test
page, status sheet, and demonstration page.

Help The Help menu contains the Help index and the
About item

To access a menu, hold down the Alt key while you press the first letter of
the name of the menu (e.g., press Alt + F to bring up the File menu). Use
the up and down arrows to select an item on the menu. Then press Enter.

Help is available for each item in the menu bar. To bring up help, move
the cursor to the item and press F1.

To move the cursor from the menu bar to the screen, press Esc.

Getting help

The status bar at the bottom of the screen provides a brief description for
each setting. For more information about the current setting, press F1.
You can also bring up the Help Index in the menu bar, which allows you
to get help for any EPSON Control Panel item. To bring up the Help
Index, press Alt + H, then press Enter. Use the up and down arrows to
move through the list of items. When you reach the item for which you
want help, press Enter.
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Using profiles

A profile is a specific set of printer settings. If you often reuse the same
printer settings, you can create a profile to easily update your printer with
predefined settings.

There are three ways to create a profile:

Use the EPSON Control Panel for DOS to change the printer settings
as needed. Then choose Save Profile in the File menu. This brings up
a dialog box that prompts you to assign a filename and choose the
directory in which to store the profile. When you complete the
information in the dialog box, choose OK.

Open an existing profile and modify the settings of the profile. To do
so, use Open Profile in the File menu to open an existing profile.
Change just those settings that you want to change and then choose
Save AS in the File menu. Enter a new filename and choose the
directory in which to save the profile.

Use the settings currently in use by the printer to create a profile. To
do so, choose Import profile From Printer in the File menu. This
brings up a dialog box that prompts you to name the profile and
choose the directory in which to store it.

When you open a profile, you can export the printer settings described by
the profile by using the Export Profile to Printer item on the File menu.

Reporter

The Reporter keeps you informed of the printer status and alerts you to
printer problems. Each time the printer status changes or an error occurs,
a message automatically appears on screen to notify you. Each Reporter
message gives you the option of disabling the particular message so that it
does not reappear until you re-enable it.

To modify certain Reporter parameters, use the hot key combination
Ctrl + Alt + R to bring up the Reporter’s main menu. The main menu
allows you to do the following:

Enable messages that you have disabled.

Review the last message displayed by the Reporter.
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Deactivate (or re-activate) the Reporter. When the Reporter is
deactivated, it does not monitor the printer and does not display
messages.

Change the hot key combination used to bring up the Reporter's
main menu.

Change the colors of the Reporter’s messages.

A help option on the menu provides a brief explanation for each topic on
the main menu.
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LJ3 Emulation Commands

Your printer emulates the Hewlett-Packard LaserJet III printer and uses
the PCL 5 command language.

This appendix lists the available printer commands for LJ3 emulation. 
Most of the commands closely emulate the original printer or the control
language; however, some have operational differences.

The following notes apply to various command in the following.
commandsummary:

1 These commands are specific to the EPSON ActionLaser 1100.

2 Secondary printer commands are specified as secondary by using a right parenthesis")" in the
command instead of a left parenthesis.

Function Command

Job control
Reset ESC E

Number of ESC &/ #X
copies

universal exit ESC %- #X
language

Long-edge ESC&/ #U
(left) offset
registration

Short-edge ESC &/ #Z
(top) offset
registration

P a g e  c o n t r o l

Paper source¹ ESC &/ OH

ESC &/ 1H

ESC &/ 2H

ESC &/ 3H

ESC &/ 6H

Parameter Decimal value Hexadecimal value

- 027 069

X=1-99 027 038 108 #...# 088

# = 1-5

# = number of 027 038 108 #...# 085
decipoints (1/720")

# = number of 027 038 108 #...# 090
decipoints (1/720”)

Eject Page 027 038 108 048 072

Standard tray 027 038 108 049 072

Manual feed 027 038 108 050 072

Manual envelope 027 038 106 051 072
feed

Envelope feed from 027 038 108 054 072
standard tray

1B 45

1B 26 6C #...# 58

1B 26 6C #...# 55

1B 26 6C #...# 5A

1B 26 6C 30 48

1B 26 6C 31 48

1B 26 6C 32 48

1B 26 6C 33 48

1B 26 6C 36 48
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Function Command Parameter Decimal value Hexadecimal value
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Function Commmd Parameter

Cursor positioning

Decimal value Hexadecimal value
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Function Command Parameter Decimal value Hexadecimal value
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Function Command Parameter

Font management

Decimal value Hexadecimal value
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Function Command Parameter Decimal value Hexadecimal value
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Function Command Parameter Decimal value Hexadecimal value
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F u n c t i o n Command Parameter D e c i m a l  v a l u e Hexadecimal value
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Function Command Parameter Decimal value Hexadecimal value
Picture frame ESC * c#x # = Decipoints 027 042 099 #...# 088 1B 2A 63 #...# 58
horizontal size

Picture frame ESC * c#Y # = Decipoints 027 042 099 #...# 089 1B 2A 63 #...# 59
vertical size

C o n t r o l  c o d e s

Backspace Es

Line feed LF

Form feed FF

Carriage return CR

Shift in SI

Shift out SO

Horizontal tab HT

Escape ESC

space SP

Select  Primary font

Select secondary font

GL/2 emulation context commands

Configuration and status group
Function

Input P1 and P2

Input relative P1 and P2

Scale

Input window

Rotate coordinate system

Initialize

Default values

Command

IF

IR

SC

IW

RO

IN

DF

COComment

Line and fill attributes group
Line attributes

Line type

User defined line type

select pen

Pen width

Pen width unit selection

Fill type

Screened vectors

Raster fill definition

LA

LT

UL

SP

PW

WU

FT

SV¹

RF
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Function

Anchor corner

Symbol mode

Transparency mode

vector group
Pm down

Pen up

Plot absolute

Plot relative

Arc absolute

Arc relative

Absolute arc three point

Relative arc three point

circle

Polyline encoded

Bezier absolute

Bezier relative

Polygon group
Edge rectangle absolute

Edge rectangle relative

Fill rectangle absolute

Fill rectangle relative

Edge wedge

Fill wedge

Polygon mode

Edge polygon

Fill polygon

Character group
Standard font definition

Alternate font definition

Primary font (standard font)

secondary font (alternate font)

Select standard font

select alternate font

Scalable or bitmap font

Absolute direction

Relative direction

Absolute character size

Command

AC

SM

TR

PD

PU

P A

PR

A A

A R

A T

RT

C I ²

PE

BZ

BR

EA

ER

R A

RR

EW

W G

PM

EP

FP

SD

A D

F I ³

F N ³

SS

S A

SB³

DI

DR

SI
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CommandFunction

Relative character size

Character slant

Character fill mode

Label

Define label terminator

Label Origin

Define variable text path

Extra space

character plot

Transparent data

SR

SL

CF

LB

DT

LO

DV

ES

CP

TD

Dual context extension
Enter PCL mode ESC %#A

Reset ESC E

 ¹Palette extension command

²Polygon group command

 ³Dual context extension command

PJL Mode

This section lists the available commands for the Printer Job Language
(PJL).

Function

COMMENT

DEFAULT

DINQUIRE
ECHO

ENTER

INFO

INITIALIZE
INQUIRE
RESET

SET

UEL/SPJL

USTATUS

USTATUSOFF

PJL

Command

@ PJL COMMENT <words> [<CR>] <LF>

@ PJL DEFAULT [LPARM] [<CR>] <LF>

@ PJL DINQUIRE [LPARM] [<CR>] <LF>

@ PJL ECHO [Words] [<CR>] <LF>

@ PJL ENTER LANGUAGE = *** [<CR>] <LF>

@ PJL INFO read only variable [<CR>] <LF>

@ PJL INITIALIZE [<CR>] <LF>

@ PJL INQUIRE [LPALM] variable [<CR>] <LF>

@ PJL RESET [<CR>] <LF>

@ PJL SET [LPARM] [<CR>] <LF>

<ESC>%-12345X

@ PJL USTATUS variable = value [<CR>] <LF>

@ PJL USTATUSOFF [<CR>] <LF>

@ PJL [<CR>] <LF>
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Memory Module

By installing a 1MB, 2MB, or 4MB Single In-Line Memory Module
(SIMM), you can increase printer memory up to 5MB. You may want to
add additional memory if you are having difficulty printing complex,
graphics-intensive pages or if you regularly use many downloaded fonts.

You can purchase SIMMs from various vendors. Be sure the SIMMs you
purchase meet the following requirements:

 72-pin type

Capacity of 1,2, or 4MB

Access speed of 70ns or less

Installing the SIMM

Warning:
High voltages are present inside the printer when the power is on. Do not
attempt to install a SIMM unless the printer is turned off.

1. Turn off the printer and unplug the power cable from the electrical
outlet.

2. Turn the printer so the back of the printer is facing you.

3. Remove the metal access cover located above the parallel connector.

Warning:
Avoid touching the electrical components that are exposed after you
remove the metal access cover. They may be very hot if the printer
has been used recently.

4.

5.

6.

7.

8.

Mount the SIMM in the slot provided for it.

Replace the metal access cover.

Reattach the power cord.

Switch on the printer’s power.

Now you need to update the printer driver’s Memory setting. Bring
up a software program that you often use to print.
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9. From the File menu, choose Print or Print Setup.

10. Choose the Setup button. (Depending on your software, you might
need to choose Options or Printer.)

11. If prompted to select a printer, select Action Laser 1100.

12. Once the Setup dialog box is open, change the Memory setting for the
amount of memory now installed in the printer. (Be sure to include
the 1MB already installed.)

13. Choose OK to close dialog boxes. When you return to the Print dialog
box, choose Cancel.

Checking the memory

To verify that memory is correctly installed, print a test sheet by pressing
the reset button at the back of the printer.

If an incorrect amount of memory is shown on the test sheet, turn off the
printer and remove the metal access cover. Make sure you correctly
installed the SIMM. If the amount of RAM is still incorrect, contact your
dealer or a qualified service person for assistance.
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Glossary

auto line feed
A printer feature in which each carriage return code (CR) is automatically
accompanied by a line feed (LF) code.

control codes
Special codes used to control printer functions such as performing a
carriage return or line feed.

default
A value or setting that takes effect when the printer is turned on, reset, or
initialized.

download
To transfer information from the computer to the printer. Fonts are
downloaded to the printer when needed.

dpi
Dots per inch. The number of dots per inch is a measure of printer
resolution. The higher the number of dots, the higher the resolution.

driver
The part of a software program that converts commands from the
program into commands used by the printer. Also known as the printer
driver.

drum
The part of the printer mechanism where the image is formed and
transferred to the paper.

edge smoothing
A feature that smooths the jagged edges of printed lines or shapes.

emulation
See printer emulation.

ESC (escape) code
A special control code used to begin most printer commands.

font
A set of characters and symbols that share a common typographic design
and style.
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halftone
A grayscale image that is composed of small dots. The dots can be close
together to create black or more widely spaced to create gray or white
areas in the image. Newspaper photographs are common examples of
halftones.

interface
The connection between the printer and the computer.

landscape
Printing that is oriented sideways on the page. This orientation gives you
a page that is wider than it is high and is useful for printing spreadsheets.

memory
The part of the printer’s electronic system that is used to store
information. Some information is fixed and is used to control how the
printer operates. Information that is sent to the printer from the computer
(such as downloaded fonts) is stored temporarily.

orientation
Refers to the direction in which characters are printed on a page. This
direction is either portrait with the text printed across the width of the
page, or landscape with the text printed across the length of the page.

PCL 5
The command language built into the Hewlett-Packard LaserJet III.

point size
The height of a particular font as measured from the top of the tallest
character to the bottom of the lowest. A point is a typographic unit of
measure equivalent to 1/72 of an inch.

portrait
Printing that is oriented upright on the page (as opposed to landscape, in
which printing is oriented sideways on the page). This is the standard
orientation for printing letters or documents.

printer driver
See driver.
printer emulation
A set of operating commands that determines how data sent from the
computer is interpreted and acted upon. Printer emulations replicate
existing printers, such as the HP LaserJet III.

r e s e t

To refresh the printer’s memory and erase the current print jobs, and reset
printer settings to the factory defaults.
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resident font
A font that is stored permanently in the printer’s memory.

resolution
A measure of the fineness and clarity of images produced by the printer
or monitor. Printer resolution is measured in dots per inch.

symbol set
A collection of symbols and special characters. Symbols are assigned to
specific codes in a character table.

test sheet
A report that lists the printer settings and other printer information.

toner cartridge
The consumable part of the printer that contains a photosensitive print
drum and the toner supply.

TrueType
An outline font format that was developed jointly by Apple@ Computer
and Microsoft Corporation. TrueType fonts are outline fonts that can be
easily resized for screen display or for printing.
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This index contains entries for this manual as well as the Read This First guide.
Page numbers from the Read This First guide are preceded by RTF (e.g., RTF-9).
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changing the settings from

Windows, 2-2
c lean ing  3 -11 -13

f e a t u r e s ,  1 - 2

monitoring the status, 1-5
resetting, 3-2
specifications, A-3-5
system requirements, RTF-1
testing, RTF-13
testing the computer connection,

RTF-14
Auto Continue, 2-4

B
Bidirectional parallel interface, 1-2

installing the cable, RTF-13
s p e c i f i c a t i o n s ,  A - 6

C

Cartridge, see Toner cartridge
cleaning the printer, 3-11-13
Clearing errors, 3-2
CompuServe membership, 2
Controlling the printer

from DOS, B-4
from Windows,  2-3—4

copies, 2-6

D

Downloading fonts, 1-11
Driver, RTF-14

E
Edge Smoothing, 1-2, 2-11

changing the setting, 3-8-9     
Electrical specifications, A-4
Energy star compliance, 1-3
Envelopes, 1-10

feeding manually, 2-5
sizes, 2-5, A-5

Environmental specifications, A-4
EPSON Accessories, 2
EPSON Connection, 1
EPSON Control Panel for DOS, B-2-7

installing, B-2
EPSON Control Panel for Windows,

1-3,1-7
deleting, 3-13
installing, RTF-16
minimizing, 1-7

Error light, 1-5—6
Errors, recovering from, 3-2

F
Faint images, 3-7
Feed jams

clearing,  RTF-22
preventing, 3-2—3

Font Manager, 2-12
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Fonts, 1-11
downloading, 1-11
installing PCL fonts, 2-12
printer resident fonts, 1-11
printing TrueType fonts as

graphics, 2-10
problems with, 3-5

Front panel lights, 1-5—6

G

Graphics
applying halftone patterns, 2-9
compressing 2-8
printing at lower resolutions, 2-5
problems with, 3-4-5

Graphics Resolution, 2-6
Gray Scale, 2-9

H

Help,
accessing from EPSON Control

Panel for DOS, B-6
getting support, 1

I

Image Compression, 2-8
Installing

additional memory, D-2—3
EPSON Control Panel for DOS,

B-2-4
EPSON Control Panel for

Windows, RTF-16
toner cartridge, 3-6

Interface, specifications, A-6

L

Labels, 1-10
Landscape orientation, 2-8
Laser scanner window, cleaning,

3-12
Line Art Images, 2-10
LJ3 emulation, 1-2

command summary, C-2—12

M

Manual feed, 1-10,2-4
Memory, 1-2

adding, D-2—3
cleaning, 3-2

Memory overflow, 2-6, 2-8
Memory setting, 2-6—7

O

Options button, 2-9
Orientation, 2-8

P

Page Protection, 2-7—8
Paper

choosing,  1-9
loading, 1-8—9, RTF-9—11
problems with jamming, 3-2-3
reloading RTF-11
specifications, A-2

Paper Peed, 2-5
Paper jams,

clearing,  RTF-22—24
preventing, 3-2

Paper Size, 2-5
Paper tray, 1-8

loading Paper, 1-8—9, RTF-9—11
Parallel interface, 1-2

installing the cable, RTF-13
specifications, A-6
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PCL fonts, installing, 2-12
PCL 5 command language, C-2
Photographic Images, 2-9
PJL mode, commands, C-14
portrait Orientation, 2-8
PostScript emulation option, 1-4
Power, conserving,  1-4,2-12
Power Save Interval 2-12
Power save mode, 1-4

s e t t i n g ,  2 - 1 2
Print quality

optimizing, 3-8—10
problems with, 3-5—8

Print TrueType as Graphics, 2-10
Printable area, A-2
Printer driver settings, 2-4—12

accessing, 2-3
resetting to factory defaults, 3-2
saving as a profile in DOS, B-7

Printer overruns preventing, 2-7 
Profiles, B-7

R

Ready light, 1-5—6
Reporter, 1-5, B-7—8
Resident fonts, 1-11

S

Safety instructions, 7
scanned Images, 2-10
Setup dialog box, 2-3
SIMM

installing, D-2—3
specifications, D-2

Status messages, 1-5, 1-7

T

Test page, printing, RTF-12
Toner

adjusting the density, 3-10
conserving, 2-1
removing spills, 3-12

Toner cartridge
installing, RTF-3—7
replacing, RTF-18—21
specifications, A-5

Toner Density, 2-11
adjusting,  3-10

Toner Saving, 2-10
Toner saving mode, 1-3
Transparencies, 1-11
TrueType fonts, printing as

graphics, 2-10

V

vertical bands, 3-5

W

window envelopes, 1-10
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